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5.1 BOOT-UP PROCEDURE 
 

The following text describes the proper procedure of starting up the main software 
modules that control the Blue Ocean VDR / S-VDRsystem.  
 
S-VDR Configurations 
There are two different configurations that the S-VDR PC may be configured to:  
- The Retail configuration which is the complete-installation-at-the-end-user 
configuration. In this state, every time the PC reboots, it will automatically log in, then 
lock itself to become inaccessible for any unauthorized users and then start the 
PROGRAM. In this configuration the only way to unlock the standard operating system 
graphical user interface is by providing the correct password to one of the PROGRAM 
modules called WatchDog.exe. (Instructions on how-to-unlock-the-system are given 
below in the WatchDog.exe description). 
- The Service configuration, where the PC will not log in automatically but instead 
it will display all the available users and demand from the user to make a selection and 
provide the correct password. The user Admin requires no password and may be 
accessed from any user. After booting the system should be started indirectly by starting 
the peripheral module WatchDog.exe. (Instructions on how-to-unlock-the-system are 
given below in the WatchDog.exe description). 
 
Switching from Service to Retail configuration. 
When the installation or testing of the system has finished it must be put into the fail-safe 
and intrusion-safe Retail configuration. In order to do that, follow the next steps: 
- Log in as the default user called Admin. 
- Delete all other users leaving only the user Admin. 
- If Admin has a password, clear it. This way the system whenever it reboots it will 
immediately load the user Admin and will demand no password. 
- Go to Start/Run and execute the OS program called MMC. 
- In the MMC/File menu select Add/Remove Snap-In, on the following window 
select Add, on the displayed list select Group Policy Object Editor, select Add, Finish, 
Close, and OK in the remaining windows respectively. 
- In the Local Computer Policy Tree go to: User Configuration/Administrative 
Templates/System. Double click on the Custom User Interface property and change its 
state to Enabled. In the small edit box labelled Interface file name write: 
C:/BlueOcean/WatchDog.exe. 
 
Software System Description 
The software is based on three different application programs. 
- BlueBox.exe: This is the main program that is responsible and it is providing all 
the VDR/S-VDR functionality of the system. Needles to say this application is absolutely 
critical for the system's performance. 
- FolderManipulation.Exe: This application is handling the free space of the 
recording devices (hard disk, capsule disk). It scans both disks in regular intervals and 
cleans up the oldest data files always leaving a minimum free space available for writing. 
This application is critical to the system's performance. 
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- WatchDog.Exe: This application is an intentionally simple thus steady program 
that monitors the state of the previous two critical applications. Its purpose is to diagnose 
their condition and if it decides that one or both of the above applications is not 
responding properly (or it does not even exist) it will restart it. The activation intervals 
are the following: 
Start up interval for “BlueBox.exe” if it not running at all: 20 seconds, 
Start up interval for “FolderManipulation.exe” if it not running at all: 10 seconds, 
Restart interval for “BlueBox.exe” if it not responding: 30 seconds, 
Restart interval for “FolderManipulation.exe” if it not responding: 150 seconds. 
 When the WatchDog runs in normal mode (default) the Task Manager is locked 
and no unauthorized user can access the system or its functionality. In order to gain 
access the service engineer must select the mode Super User and provide the proper 
password to unlock this mode. 

 

 
 

Immediately after the program switches to Super User mode the Task Manager will be 
unlocked and the authorised user may now start the Explorer.Exe through the menu 
Start/Run/Explorer.Exe. 

 

 
 

The Super User can prohibit the WatchDog from constantly restarting the critical 
applications by unselecting the Respawn S-VDR label. When exiting, the WatchDog 
automatically locks the Task Manager. To prohibit that select the Set Exit Without 
Locking label. 
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5.2 SETUP GUI (Graphical User Interface)   MANUAL 
 

Purpose 
 
The VDR / S-VDR can accommodate a variety of Data Items and configurations. All the 
necessary settings for a specific installation are kept in a separate database allowing the 
technical staff to update the setup configuration whenever there is change at the ship 
hardware. 
The purpose of the Setup Program is to speed up the configuration of the S-VDR system 
by speeding up the configuration of the database. It helps build up a graphical description 
of the physical connections of the system and then configure each item on the graph 
according to the installation specifics. It is absolutely essential that all the information 
passed to this program represent the physical connections of the system otherwise the S-
VDR will not operate properly. In other words every graphical representation must 
correspond to an actual physical connection, a cable, a wire or a plug. The program will 
export all this information to the installation database. 
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5.2.1 DESCRIPTION OF THE VDR / S-VDR HARDWARE 
 
DATA RECORDER 
The term DataRecorder is used to represent the S-VDR Main Unit. The setup program 
displays only the parts of the DataRecorder that it is interested in, so do not be puzzled if 
essential units such as the system screen or the Float-Free Capsule do not appear on the 
graphical description of the system. Only units that need to be configured separately at 
every new installation are displayed here. The DataRecorder appears in the 
Configuration Window at the root position of the graph and is always drawn in Black 
color. 
Properties : 
- Name  : This is the mnemonic name of the unit and may be changed freely 
   by the installer. 
- Comments : Any kind of comments for the specific unit may be added here. 
 
 These two properties are common for all the graphical items used in this program 
and have exactly the same meaning wherever met. For this reason the description of these 
two properties of other items will be skipped. 
 
PORTS 
The S-VDR main computing unit communicates with most of its external modules 
through serial ports which in this text will be called “Ports”. When a serial port is 
presented with black colour it is unconnected and available for connection to a serial 
device. When it is presented with grey colour the port is already used (as in all cases 
where an item appears in grey). If all ports are used and more devices need to be 
connected, more ports have to be added to accept these devices.      

 
Note  To get details about the number and type of the Serial Com ports of your 
  system go to: 
  "Start / Settings / Control Panel / System / Hardware / Device Manager 
  / Ports COM & LPT". 

 
 

 
Ports 

 
 To physically install more serial ports to the system consult the S-VDR Technical 
Manual. 
Properties : 
- Com Port  : This is the serial com port which this Port represents. 
- Baud Rate : This the desired baud rate of the serial com port. Use the baud 
   rate of the physical device connected to the port to achieve proper                  
   communication. 
 
 
PLC 
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The PLC (Programmable Logic Controller) is connected directly to the serial port and 
can accept a variable number of modules according to its type and model. For this reason 
the number of PLC (or PLC module) inputs may be easily changed from the 
corresponding property on the property window. All PLC units and their modules are 
coloured in blue to distinguish them from other items.  
Properties : 
- Address  : a unique address to identify the PLC. 
- Analogue Inputs : the number of analogue inputs of  the PLC.  It can be  
    changed at anytime simply by updating the number from the 
    Properties Window. 
- Digital Outputs : the number of digital outputs. It may be updated. 
- Digital Inputs : the number of digital inputs. It may be updated. 
 

 
 

PLC Module 
 

ANALOG PLC MODULES 
This is not a stand-alone unit. It is an add-on to the main PLC and for this reason it 
appears as a child node of the main PLC. Up to seven modules may be added to the each 
main PLC unit. 
Properties : 
- Analogue Inputs : the number of analogue inputs of the PLC.  It can be  
    changed at any time simply by updating this number from the 
    Properties Window. 
 
DIGITAL PLC MODULES 
This is not a stand-alone unit. It is an add-on to the main PLC and for this reason it 
appears as a child node of the main PLC. Up to seven modules may be added to the each 
main PLC unit. 
Properties : 
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- Digital Inputs : the number of digital inputs of the PLC. It can be changed at 
    anytime simply by updating the number. 
- Digital Outputs : the number of digital outputs of the PLC. It can be changed 
    at anytime simply by updating the number. 
 
NMEA ADAPTER MODULES 
The NMEA Adapter as a physical unit consists of two different modules. A 9-input serial 
multiplexer with multiple inputs - one output and a single input - single output converter. 
In its representation in the Setup utility though, the module is split into two different 
modules as seen in the image below.  

- Multiplexer: The data reaching its inputs are grouped and transmitted 
consecutively through its output. Furthermore this unit will only retransmit the 
legal NMEA data strings. The single output has to be much faster than the 
inputs in order to transmit all the incoming data. The output speed of the 
NMEA Adapter modules is at least 19200bps while the NMEA signals 
according to their standard are communicating in 4800bps and for this reason 
NMEA Data Items can be perfectly handled by this module. Connect all 
NMEA data sources to the NMEA Adapter multiplexer inputs. The first input 
is occupied by other hardware leaving 8-inputs to the user.    

- Converter: This is a high speed RS485 to RS232 converter to handle sources 
such as the AIS. It occupies a separate serial port. 

 
Note  Use the NMEA setup program to observe the incoming data. 

 

 
 

Two types of NMEA Adapter Modules 
Properties : 
- Channels : the number of serial inputs. It depends on the type of the NMEA 
   Adapter module and for the moment it cannot be changed. 
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- Type  : the type of the module, Multiserial for the multiplexer or Serial for  
the converter. 

 
SERIAL MODULES 
A serial module appears to be similar to a port, that is, a serial communication port. In 
reality though, it is a software module designed to process incoming data and for this 
reason, it is  represented separately by the program. In case a serial device does not use 
the standard NMEA 4800bps baud rate or does not follow the standard NMEA protocol, 
connect it to a serial module. Serials modules can have baud rates as high as 1Mbps. For 
more details check the S-VDR Technical manual. 
 

 
Serial Module 

VIDEO 
 This module represents the software module that is responsible for previewing and 
capturing the incoming video signal (radar). No other item needs to be connected to this 
module, the installer must simply update the settings appropriately. 
Properties : 
- JPEG Quality : This is the quality of the compressed video frame. It accepts 
    any number from 0 to 100 and the higher it is the better the 
    quality, the larger the file size also. A good compromise is a 
    number around 70. It really depends on the size of the storage 
    unit and the resolution of the screen. 
- Capture Interval : This is the time interval in milliseconds at which the module 
    will save a video frame.    The default value is 15000 (15 
    seconds). 
- Encoder  : Type of encoder, JPEG or PNG. 
 

 
 

The Video, Files, Sound, System Modules 
 

FILE MANIPULATION 
This module represents the software module that cleans up the storage devices regularly. 
Nothing needs to be connected to this module, the installer must simply update the 
settings appropriately. 
Properties : 
- File Scanning Time : The time interval at which the module will perform storage 
    clean up. 
- Free Limit 1  : The minimum free space for storage unit 1. 
- Free Limit 2  : The minimum free space for storage unit 2. 
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- Path1   : The path for the storage unit 1. 
- Path2   : The path for the storage unit 2. 
- Capsule Type  : The type of the Capsule. 
- Path2   : The path for the storage unit 2 

 
Note  It is recommended to use the default values for this Module. 

 
 
SOUND 
This module represents the software module that records the audio.  
Properties : 
- Microphones  : The number of the microphones. 
 
BUZZER 
These modules represent the buzzers that are attached to the microphones. The following 
properties have to be setup correctly in the audio testing so that the Sound module FFT 
filter can locate the buzzer signal for each microphone. 
Properties : 
- Frequency  : The dominant frequency of the buzzer signal, 
- Intensity  : The intensity of the buzzer signal. 
 
SYSTEM 
This module contains additional system settings. 
Properties : 
- Brightness  : Index of the analogue input controlling the Brightness, 
- 24V_OK channel : Index of the digital input of the 24V power OK signal. 
- 230V_OK channel : Index of the digital input of the 230V power OK signal. 
- System24V channel : Index of the analogue input sensing the 24V. 
- System24V High Lim: Maximum acceptable value for the 24V power. 
- System24V Low Lim : Minimum acceptable value for the 24V power. 
- System24V A  : Multiplier for the 24V sensing. 
- Converter  : If true the communication to the PLC is through a RS485 to 

RS232 converter. 
 

 
Note  It is recommended to use the default values for this Module. 
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INPUTS 
The inputs represent the physical connectors where cables or plugs are connected to. 
They may be serial inputs or PLC analogue or digital inputs etc. They are represented 
with green colour unless they are already used in which case their colour changes to grey.     
An input is a slot of a specific type that may accept an object (called Data Item) of the 
same type only. This, of course, in the physical setup is very straightforward since an 
analogue input naturally accepts an analogue signal. More specifically the inputs are 
divided into the following categories: 
   
DIGITAL INPUTS 
A digital input will accept a digital signal (Data Item). Only one Data Item is accepted 
per digital input. For specifications check the S-VDR Technical Manual. 
 

 
Inputs 

 
ANALOGUE INPUTS 
An analogue input will accept an analogue signal (Data Item). Only one Data Item is 
accepted per analogue input. For specifications check the S-VDR Technical Manual. 
 
NMEA INPUTS 
Several NMEA Data Items may connected to the same NMEA input. This is because a 
single NMEA serial device may transmit several NMEA signals.  
 
SERIAL INPUTS 
Several Serial Data Items may be connected to the same Serial input. This is because a 
single Serial device may transmit several Serial signals.  
 
DATA ITEMS 
A Data Item (DI) is a ship signal, a ship property that needs to be recorded.     Physically 
a Data Item may be anything from Engine rpm, to analogue or digital signals, to open or 
closed doors, wind direction, but technically all these different signals will either be 
Analogue, Digital, NMEA or Serial Data Items (DIs). The DIs are either Mandatory 
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ones, which are represented in red colour or Optional that can be created by the installer 
and are represented in purple color .  

 
Note  Mandatory DIs are required by the IMO and must be recorded.  

 
All DIs initially lay on the right hand side of the Setup Program in the Data Items 
Window. 

 
Note  It is important for the installer to realize the following concept. A Serial 
  Device usually transmits several different Serial Data Items. Thus, a  
  physical cable connected from a Serial Device to an NMEA input for 
  example, will usually carry more than one Data Items. For this reason a 
  Serial or NMEA input will accept more than one Data Items. 

 
 

 
Data Items 

Properties : 
- Name  : The mnemonic name of the Data Item. Only the Name of the 
   Optional DIs can be changed. 
- Comments : Installer comments. 
- Channel : The channel is the input index of the module where the Data Item 
   is connected. This property is automatically set when the installer 
   places a Data Item on an input. 
- Type  : The Data Item type property describes its electrical type. It can 
   be Analogue, Digital, NMEA (serially transmitted signal of NMEA 
   standard), Serial or Generic. The Generic type states a Data Item 
   which has no default type and can be placed in any type of input.     
   Immediately after placement a Generic  Data Item will inherit the 
   input's type. 
- Destination Type : This property is only visible for Optional IMO Data Items.     
   The installer  must select one of three possible choices: 
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   - IMO, 
   - Firedoor, 
   - Onening.  
 
DIGITAL DATA ITEMS 
Properties : 
- Active State : If  -1- active High, if -0- active Low. 
 
ANALOG DATA ITEMS 
 The analogue DIs are normalized to a range of values with the use of a linear 
function of the form A x + B. 
Properties : 
- A  : The A variable of the function, 
- B : The offset factor of the function. 
 
NMEA DATA ITEMS 
 NMEA DIs are normalized to a range of values with the use of a linear function of 
the form A x + B. 
Properties : 
- Sentence : a five character string where the first two characters are the          
   talker identifier mnemonic for the specific device and the following 
   three characters are a valid NMEA sentence formatter. 
- Field 1 : a number holding the index of the first field of the message, 
- Field 2 : a number holding the index of the second field of the message, 
- Length 1 : the length of the first field of the message, 
- Length 2 : the length of the second field of the message, 
- Delimiter 1 : the first delimiter between fields,  
- Delimiter 2 : the second delimiter between fields. 
- A  : The A variable of the linear function, 
- B : The offset factor of the linear function. 
 
SERIAL DATA ITEMS 
 Serial DIs are normalized to a range of values with the use of a linear function of 
the form A x + B. 
Properties : 
- Sentence : for Optional serial devices, this is a string of characters that is     
   characteristic of a Data Item, so that the system can distinguish it 
   from other Data Items coming from the same device. 
- Field 1 : a number holding the index of the first field of the message, 
- Field 2 : a number holding the index of the second field of the message, 
- Length 1 : the length of the first field of the message, 
- Length 2 : the length of the second field of the message, 
- Delimiter 1 : the first delimiter between fields,  
- Delimiter 2 : the second delimiter between fields. 
- A  : The A variable of the linear function, 
- B : The offset factor of the linear function. 
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5.2.2 DESCRIPTION OF SHIP RECORDED DATA ITEMS 
 
NMEA DATA ITEMS 
The NMEA Data Items are signals coming from sources using the NMEA interface and  
should exist in every ship. They are sent by one or more different ship devices so it is up 
to the installer to select the device to get each signal from. The NMEA protocol expects a 
certain format for each signal, so the installer must ensure that the Setup configuration 
truly follows that format or the system will not recognise it. In such a case the properties 
of the Data Item may be adjusted. In any case if a Data Item is transmitted with a baud 
rate different than 4800 bps, this Data Item should be connected to a separate serial port.     
 The following Data Items  are pre-defined and appear in the Data Items Window: 
- Date     - NMEA  
- Time     - NMEA 
- Latitude    - NMEA 
- Longitude    - NMEA 
- Speed     - NMEA or Analogue 
- Heading    - NMEA or Analogue 
- Depth     - NMEA or Analogue 
- Rudder Order    - NMEA or Analogue 
- Rudder Response   - NMEA or Analogue 
- Engine Order    - Analogue or NMEA 
- Engine RPM    - Analogue or NMEA 
- Propeller Order   - NMEA or Analogue 
- Propeller Pitch   - NMEA or Analogue 
- Wind Speed    - NMEA or Analogue 
- Wind Direction   - NMEA or Analogue 

 
MANDATORY ALARMS 
The following alarms must be recorder according to IMO resolution A.861.    They are 
pre-defined and appear in the Data Items Window: 
- Steering Power   - Digital 
- Steering Control   - Digital 
- Steering Low Fluid   - Digital 
- Propulsion Remote   - Digital 
- Propulsion Starting Air  - Digital 
- Propulsion Shutdown  - Digital 
- Fault Attn Request   - Digital 
- Alarm Power    - Digital 
- Alarm State    - Digital 
- Watertight LowFluid  - Digital 
- Watertight Low Pressure  - Digital 
- Watertight Electrical  - Digital 
- High Water Ararm   - Digital 
- Shell Door    - Digital 
- Water Leakage   - Digital 
- Fire in Machinery   - Digital 
- Fire Detection   - Digital 
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- Smoke Detection Power  - Digital 
- Smoke Detection   - Digital 
- Halon Loss    - Digital 
- Halon Electric   - Digital 
- Halon Power    - Digital 
- Halon Release   - Digital 
- Personnel Alarm   - Digital 
 
OPTIONAL DATA ITEMS  
Any Data Item that is not a standard IMO but needs to be recorded, is called an Optional 
Data Item. An Optional Data Item is created by the installer to meet the needs of a 
specific application 
Properties : 
- Type   : The type of an Optional Item is automatically assigned to it 
    once it placed on an input. It will inherit the type of the 
    specific input. 
- Desination Type : this property can take three possible values: 
 -  IMO  :A Data Item required by IMO standards which cannot be 
    found  in the mandatory alarms. 
 - FireDoor :A Data Item capturing the state of a firedoor. 
 - Opening. :A Data Item capturing the state of a hull opening. 
 
 

 
Mandatory Optional DIs
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5.2.3 DESCRIPTION OF THE SETUP WINDOW 
 
MENU BAR 
The menu bar lays at the top of the Setup Program window and contains three submenus 
called "Project", "Modules" and "Help".  
 

 
The Setup GUI 

 
PROJECT submenu 
The Project submenu contains the following commands: 
 

 
'Project' Commands 

 
- New: Create a new configuration file. This will clear all windows and load a 
 default Configuration tree and a default Data Items list. 
- Open: Open a previously created configuration file. 
- Save: Save the current configuration file. 
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- Save As: Save the current configuration file under a new name. 
- Configuration Upload to S-VDR: Once the project is complete the Setup will 
 upload it to the Free-Floating Capsule and the S-VDR will use it as its default 
 configuration. This command will NOT appear unless the project is saved with a 
 name other than the default one and all the DIs have been connected properly. 
 If the above prerequisites are satisfied and the command is clicked the form below 
 will appear. All three fields must be filled for the program to go forward and 
 copy the current project configuration into the Free-Floating Capsule as the active 
 configuration. 

 

 
Configuration Upload Form 

 
- Close:  Close the project. 
- Exit Program: Exit the program after saving the project. 
 
 
MODULES submenu 
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The Modules submenu contains all the available I/O modules that may be added to the S-
VDR system. As explained in chapter 3.3, this submenu and/or its items are only enabled 
when the installer has selected an item in the Configuration Window on which a module 
may be added to.     
 

 
'Modules' Commands 

 
 The submenu contains the following items: 
- Port   : Add a new port to the DataRecorder. 
- PLC Main    : Add a new PLC to a port. 
- Analog Module : Add a new Analogue module to a PLC. 
- Digital Module  : Add a new Digital module to a PLC. 
- NMEA Adapter  : Add a new NMEA Adapter to a port. 
- Serial Device  : Add a new Serial device to a port. 
 
HELP submenu 
 The Help submenu contains two options: 
- Manual : Open this manual. 
- About  : Information about the current program version. 
 
TOOL BAR 
 
 The Tool bar contains the following items: 
- New project: a shortcut to the menu command. 
- Open project: a shortcut to the menu command. 
- Save project: a shortcut to the menu command. 
- Undo change: undo the last change. The program keeps a list of up to 65 changes. 
- Redo change: redo the last undo operation if there is one. 
- Auto-place Data Items: see chapter 3.3. 
- Semi-Auto-Place Data Items: see chapter 3.3. 
 

 
The Tool Bar 
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CONFIGURATION WINDOW 
 
The Configuration Window displays a graphical representation of the physical 
connections of the S-VDR system. The graph is shown as a tree where the root is on the 
left hand side and the branches are on the right hand side. To add a new node to the graph 
the installer must click on the position where that node must be inserted. This position is 
the Parent node.      
 

 
Modules submenu 

 
The submenu labelled "Modules" on the menu bar will be updated and depending 

on the type of the Parent, will allow access to its sub-items or not.  This way the system 
leads the installer to add every node to its proper place. Once the parent node is clicked 
and a sub-item on the Modules menu is enabled, the installer can select it and this way 
add a Child node to the graph. This way, when the DataRecorder is selected only a Port 
may be added, when an empty port is selected a PLC main unit or a NMEA Adapter or a 
Serial Device may be added, when a PLC main is selected either an Analogue or a Digital 
module may be added. 
 Whenever a node is clicked on the Configuration Window four different items on 
the form are updated automatically.      
- The Properties Window displaying the properties of the selected node,  
- the Message window giving help on the selected node,  
- the Modules menu as explained earlier and  
- the tree pop-up window. 
 

 
Right-click Popup Window 
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 By right clicking on top of the graph the pop-up window will appear with more 
commands for manipulating the tree. Through the tree pop-up window the installer can 
delete nodes (only the ones allowed), expand or collapse the tree and clear a tree branch 
from all the Data Items that may be connected to it. Navigate through the different nodes 
of the tree and notice these four groups changing and offering different details for each 
node.     
 In order to place a Data Item on the tree the installer must drag and drop an item 
from the Data Items Window on top of the appropriate Input. All empty Inputs are 
marked with green colour while all Data Items are marked with red colour. A DI must be 
dragged onto an input and if it is allowed to move to that input the operation will be 
completed successfully. Optional DIs may be placed in any input even though they are 
initially declared as Digital. Mandatory DIs in general must be placed to an input of the 
same type.   

 
Note  Some mandatory  NMEA and Analogue DIs do not follow the above rule. 
  This is because they can either be found in NMEA or  Analogue form. For 
  example the Speed DI is as default NMEA but may also be found as an 
  Analogue 0 - 10V signal. Notice that the program will allow this DI to be 
  placed either on a NMEA or an Analogue input.                           

 
 
 If a DI is misplaced or simply needs to be put in a different location it may again 
be dragged and dropped even within the same window.      
 Apart from dragging and dropping the Toolbar buttons "AutoPlace" and 
"SemiAutoPlace" may be used. 
- SemiAutoPlace: This function will scan the unconnected DIs in the Data Items 
Window one by one and will look for an open Input of the same type. If such an input is 
found in the configuration, the DI will be moved on it. The scanning will begin from the 
selected DI and when it finishes searching it will move the selection to the following 
object. If the installer wishes to continue the function he must press the button again. This 
way object by object, if there are enough inputs available, all the DIs will move onto the 
configuration tree.  

 
Note   Only the visible inputs will be looked upon. This way the installer can 
  avoid filling up certain modules simply by hiding their inputs. 
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- AutoPlace: This function needs to be run only once and it will place all 
unconnected DIs to any visible, empty input it can find. It is faster but the installer has 
less control on its actions. Feel free to experiment with their use. The "Undo" button is 
always available for use. 
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DATA ITEMS WINDOW 
 
The Data Items (DIs) Window displays the default list of NMEA  DIs that must be 
recorder by the system. They are displayed in red colour not simply to differentiate from 
other objects or groups, but also because it is very important to connect all the DIs to 
appropriate inputs before the system can continue. DIs are really important and all of 
them have to be connected before the system starts operating. When an item on the Data 
Items list is clicked the Properties Window displays its properties.  
    The installer may change these properties before or after placing the object on the 
configuration tree. 
 By right-clicking on top of the Data Items Window a pop-up window appears with 
two selections. 
- Add an Optional IMO DI or, 
-  Delete the Optional IMO DI under the mouse tip.      
 

 
Add / Delete Optional Data Item 

 
- Sort the DIs by name, 
- Sort the DIs by type (Analog, Digital, NMEA etc). 
 Optional IMO DIs appear in purple colour and do not necessarily have to be 
connected to the configuration tree in order for the S-VDR system to begin operating.     
For the pre-defined Mandatory Data Items there are limitations concerning the DI's type.     
It is illegal and logically incorrect to try and change an NMEA Latitude DI  type to 
Digital so the program will not allow that. On the other hand some NMEA DIs could be 
substituted from Analogue ones (for example engine order could be read from an 
analogue 0-10V signal). Although the program will not allow changing a predefined DI 
within the Data Items Window, it is possible to do this indirectly. Simply drag the DI and 
drop it into an open analogue slot in the Configuration Window. Then select the DI by 
clicking on it and notice that its type has changed from NMEA to Analogue. 
If you drag the DI back to the Data Items Window it will regain its initial pre-defined 
settings. The purpose of this indirect transformation is to discourage the installer from 
doing unnecessary changes. 
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 Optional Data Items on the other hand must be configured according to their 
source so it is usually expected from the installer to make several changes in their 
properties. 
 
PROPERTIES WINDOW 
 
The Properties Window is responsible for presenting the properties, that is, data that the 
S-VDR system is interested in, in order to run properly. As the installer selects different 
items either on the Configuration or in the Data Items Window the Properties Window 
updates its appearance in order to present the specific properties for each item.    When 
the user changes the value of a property this value is updated immediately.     
 You will notice that many properties such as the DI's Channel or any object's ID 
appear in grey colour and cannot be changed. These are read-only properties and their 
value is automatically handled from the program. Properties that appear in Dark-Green 
colour may be changed. 
 

 
The Properties Window 

 
MESSAGES WINDOW 
 
The messages window displays useful information, about the object most recently 
selected, on the graph. 
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The Messages Window 

 
COLOUR SIGNIFICANCE 
 
- Grey colour : It informs that the node is already connected and cannot accept 
   another connection. It may appear in several different types of 
   nodes. In general "Grey" suggests something read-only or        
   disabled. 
- Black colour : The Datarecorder and its Ports appear in Black colour, 
- Blue colour : It informs that that the node is a module or sub-module, 
- Green colour : The node is an Input, 
- Light Green  : The node is protected system Input, 
- Red colour : The node is a Data Item, 
- Purple colour : The node is an Optional Data Item. 
 
STARTING-UP THE PROGRAM 
 
The program starts up with no project loaded so the Configuration and Data Items 
Windows appear empty. Use the Project menu commands to define the project you will 
work on. For example to start a brand new project use the 'New Project' command and 
the program will require a new project name. To continue work on a previously defined 
project use the 'Open Project' command. 
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5.2.4 CONFIGURATION PROCEDURE 
 
DATA ITEM ENUMERATION 
 
Firstly the installer must identify all the Data Items shown on the Data Items Window and 
the devices that provide them. Once again note that unless all the standard NMEA signals 
(shown in red colour) are placed on inputs, the S-VDR recorder will not operate properly. 
Most of the DI  types will match the default types but some of them may be different so 
the installer must update these types. If there are Optional Data Items that must be 
recorder the installer has to add them to the Data Item list and set them up accordingly.      
Enumerating and setting up these DIs properly is important to estimate the number and 
type of modules that should be added to the system. Although it is easy to add or remove 
modules from the Configuration Window of the Setup program, this may be a little more 
inconvenient at the physical setup.      
 Use the Comments property of each DI for any kind of remarks that may be useful 
later on. 
 
SYSTEM MODULES ENUMERATION 
 
Once the Data Items list is ready the next step is to add or remove modules accordingly, 
so that the inputs of each type are enough to accept the DIs. The whole idea behind the 
Setup Program is not just to assist setting up the system but also to record a reliable and 
simple to use map of the system. For this reason the installer should try and arrange the 
modules on the Configuration Window so that they appear as closer to reality as possible 
and vice versa.    
 If the number of the module inputs on the graph does not match the actual ones it 
is easy to correct it simply by clicking on the specific module and changing its inputs 
number from the Properties Window. The module will be updated and the number of 
inputs will match the inputs stated on the Properties Window. Make sure that all the 
graphical modules' inputs match the inputs of the actual modules. 
  
CONNECTIONS 
 
The next step is to place the DIs on the empty input slots. The program will make sure 
that DIs and inputs of incompatible type cannot be connected to speed up the process and 
avoid possible errors. Once a DI is placed on an input its properties will be updated to 
coordinate to the input's properties. It is worthwhile arranging the physical connections in 
a way similar to the graphical representation of the program because it is going to assist a 
lot when trying to debug the system. 
 
SYSTEM CONFIGURATION 
 
When all the DIs have been moved from the Data Items Window to the Configuration 
Window the installer must make sure that all of the properties of the items in the 
configuration tree agree with the physical setup of the system. The program itself has no 
automated way of presenting these properties so the installer must go through all of the 
items and update them. It is suggested to go through the tree in layers starting from the 
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Recorder Ports and then move to the modules, the inputs and the connections. If all the 
mandatory DIs have been on the configuration tree and a name other than the default 
'Newfile.bin' has been given to the project, the 'Upload Configuration to S-VDR' 
command will be active and ready for use. Close the S-VDR main program and update 
the configuration database. Restart the S-VDR main program with the configuration you 
just installed.    
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5.3 RADAR MODULE  
 
 The Radar Module's purpose is to capture a video frame coming from an external 
video source and save it as an image to disk. The incoming video may be previewed in a 
separate window so that the user/installer can check the state of the video source and the 
video connection itself.    In order to  save CPU processing time the preview video is only 
processing 5 frames per second.  
 There are two different types of video grabber units that are currently used by 
Comas, the UFG-03 by Unigraph and the VGA2USB by Epiphan. Use the appropriate 
installation according to the type of video grabber that your system is equipped with. 
 
5.3.1 UFG-03 VIDEO GRABBER CARD INSTALLATION 
 
 Here follows the installation and setup procedure fot the UFG-03 video grabber 
card by Unigraf. 
 
5.3.1.1  Card Installation 
_______________________________________________________________________ 
 
Note  The UFG - 03 is a highly dedicated electronic device that contains ESD 
  sensitive components.    Before opening the anti-static bag and always 
  before touching the card ground yourselves. 
_______________________________________________________________________ 
 
 The UFG-03 has two version labels attached to it.    They give information about 
the assembly version of the unit and the versions of the factory configured programmable 
devices on the unit.    The labels are: 
- Serial number and hardware version label, 
- FPGA code version label. 

 
UFG-03 Side View 

 



Comas                Blue Ocean VDR / S-VDR  Setup Manual                                             
 

                                                                     5.   17/7/2007 26 

_______________________________________________________________________ 
 
Note  Whenever contacting Comas for information or help, please have this 
  information available. 
_______________________________________________________________________ 
 
- Switch off the Main Unit and install the UFG-03 card into a free PCI slot. 
 
5.3.1.2  Driver Installation 
 
 For installing the UFG video capture driver on Windows XP, perform the 
following steps: 
- Boot the Main Unit, 
- Log in as system administrator. 
 
The Plug and Play subsystem of the Windows WP will detect the newly installed UFG-
03 board.    In this case the "Found New Hardware Wizard"  launches automatically.    If 
for some reason the system did not start the Wizard, do this manually by selecting 
Control Panel > Printers and Other Hardware > Add Hardware ( or when switched 
to the Classic View of the Control Panel), by double clicking on the Add/Remove 
Hardware icon ). 
  
When the "Hardware Wizard" opens, insert the Flash Disk with the UFG-03 installation 
into a free USB port and click Next. 
  

 
 

When Windows XP has found the driver, click Continue Anyway to confirm the 
installation of the driver. 
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After Windows XP has installed the driver, click Finish.    The installation is complete. 
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5.3.1.3  UFG VIDEO GRABBER INPUT CONFIGURATION 
 
To achieve the maximum quality in video frame grabbing, the input of the grabber must 
be configured using the procedure to be described in the following lines.  That is 
necessary because although there is an automatic detection in the "Configure Video 
Source" form, this detection does not include the value of the "Phase" parameter.  This 
must be done manually. 
 

 
 

Properties - Video Source 
 
Step 1. Connect the output of the radar to the input of the video grabber and make 
sure that the radar output contains as much information and bright colors as possible.  
This will assist the auto detection for a more efficient measurement.  If the "Auto 
Capture" option is set then go back to the main form and reset it. 
Step 2. Set the "Phase" to 128 which is the mid value as it may vary from 0 to 255. 
Click the "Detect Timing" button and the resolution settings should change to display the 
Radar output resolution. 
Step 3. Click "OK" to accept the settings and close the "Properties" form.  At the 
main form click "Capture" to capture a frame of the radar image with the current settings. 
Step 4. Click the "Full Size" button to go to the full size mode and observe the 
image closely. If the phase is well tuned you should not see any blinking or drifting at all.  
Then examine the captured file using an image editor.  
Step 5. Zoom into the image and check the following: 
If the auto detection was correct then the horizontal lines should not be shifted a lot. 
Check the image limits (up, down) to make sure that no line is clipped or added to the  
captured image.  If a line is clipped then the auto detection probably failed.  
Go back to Step 1. 
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Step 6. Check the following: 
- Vertical lines, because poor synchronization affects them more.  If there is 
distortion in the neighboring pixels then the phase must be adjusted.  If there is an idol of 
the vertical line drifting to the right then increase the phase and if it is drifting to the left 
decrease the phase. Use small steps of no more than 10.  
- Check the image limits (left, right) to make sure that no line is clipped or added to 
the captured image.  If a line is clipped from the left side then increase the phase 
otherwise decrease it. Use large steps (10 – 50). 
Go back to Step 3. 
 
Note Decreasing the phase shifts the captured image to the left.  Increasing the 

phase shifts the image to the right.  If the phase value is moved more than it 
should then the image will be clipped either left or right. 

 
 
5.3.1.4  TROUBLESHOOTING 
 
PROBLEM EXPLANATION 
Video preview is grey The video card is working properly.    There is no 

signal coming on its input. 
Possible errors 
-  Radar is off 
-  Radar output is disabled 
-  Video signal cable is bad or disconnected 

Video preview is black There is a hardware problem with the video card 
driver.     
Possible errors 
-   Make sure the card is properly plugged into the 
PCI slot. 
- Go to the Device Manager and check for a 
problem in the card.    If there is a problem reinstall 
the driver. 
 
If the problem is not fixed contact the technical 
support. 
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5.3.2 EPIPHAN VGA2USB FRAMEGRABBER  INSTALLATION 
 
Ø Run the Setup.exe installer of the frame-grabber utility and drivers, 
Ø Right click on the "v2uwdm.inf" file and select "Install", 
Ø Connect the USB frame-grabber in a free USB port, 
Ø The windows driver installation guide will run: select automatic search.  The 

search will display two drivers : select the top one and proceed.  The installer will 
finish and then restart for a second time : select automatic search again. 

Ø Copy the files "ViCap_DirectShow_1.exe" and "ViCap_DirectShow_1.dll" in the 
"C:/BlueOcean" directory replacing the old files. 

Ø Run the "ViCap_DirectShow_1.exe" program, make sure that the "VGA2USB" 
option is selected on the bottom-right drop-down menu, and close the program. 

Ø Connect a source to the USB FrameGrabber. 
Ø Start the VGA2USB utility.  The input VGA signal should appear in its main 

window.  Go to "Capture / Options / Adjustments" and configure the grabber 
(detailed procedure explained below), then close the utility. 

Ø Run the "ViCap_DirectShow_1.exe" program and press "Show" to check that the 
VGA source is displayed properly. 

 
Configuring the VGA2USB FrameGrabber 
 
To capture an image, go to 'Autosave' menu, select the output directory, then check the 
'Enable autosave' checkbox and click on the 'Apply' button.  Wait a couple of seconds 
and unselect the 'Enable autosave' option. 
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If there is clipping of the source signal, select the "Shift Horizontal" or "Shift Vertical" 
check boxes and adjust accordingly. 
 

 
 
To adjust the "offset/gain" settings do the following: 
5 Apply at the source a full-screen image that contains black (0,0,0) and full gain 

blue, red and green lines (for example the "VDR12x1_1.png" file). 
6 Put the Gain to zero and adjust the Offset so that the captured image 'Black' pixels 

have RGB values around (8,8,8). 
7 Then adjust the Gain so that the full-color lines have RGB values just below 

(255,255,255).
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5.3.3 RADAR SETUP 
 
 The radar setup dialog assists the installer to configure the Radar module properly. 
First select the proper type of VideoGrabber unit at the bottom-right corner of the form.   
Select “UFG” for the UFG-03 card, “EPIPHAN” for the Epiphan VGA2USB 
framegraber.   There is a third option “VGA2USB” which is an alternative for the 
Epiphan grabber but it must also be selected in case the system does not have a video 
grabber unit. 
     
- Show : this button will reveal the Preview Window with the incoming video 
signal from the radar. The preview window is fully moveable and resizable.   
 

 
 

The Radar Setup Form 
 
- Hide : this button hides the preview window.    The preview window may be re-
opened at any time pressing the Show button. 
- Full Size : this button displays the Preview window in Full-Screen mode.     This 
way the user/installer can check the Radar signal in full resolution.    In order to return 
back to the Normal-Screen mode simply click any mouse button or keyboard key. 
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Properties Form 

 
- Properties (UFG card only): this button displays the video card configuration 
pages.     From these pages the video card input can be configurated to the specific Radar 
video signal. 

 

 
 

Properties - Video Source 
 
 - Video Source : from the video source dialog select the page "RGB" or 
 "Digital" according to the output of the Radar and press the Detect Timing button.    
 A couple of seconds later the system will update the dialog with all the new values 
 discovered in the detection process.    Click "OK" to accept them or manually set 
 the various properties to get the best outcome.  
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Properties - Video Format 

 
 - Video Format:  select the format of the output of the Radar. 
 

 
 

The Radar Setup Form 
 
- Capture : this button captures a single frame of the incoming video image. 
- Image Encoder (UFG card only): Selects which encoder to use (JPEG or PNG).  
Use PNG type of files. JPEG allowed only in secondary input, if fitted. JPEG quality is 
not sufficient for main RADAR: use the PNG encoder which is lossless. 
- JPEG Quality (UFG card only): this is the quality of the video image snapshot 
that is saved to the disk.    It accepts any number from 0 to 100 where 0 is the lowest 
image quality and 100 is the highest image quality.    Also note that the higher the quality 
the much higher the size of data that each image occupies on disk.    A good compromise 
is to use values between 60 and 80. 
- Auto Capturing : when selected the Radar module takes snapshots of the video 
signal at a fixed rate of one every 15 seconds.     The first snapshot is taken immediately 
after the selection. 
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5.4 SOUND MODULE 
5.4.1 Purpose of the manual 
The VDR/S-VDR system uses this module to record sound coming from the system sound mixer 

and to conduct microphone tests. The installer can test the module and its peripherals by Starting 

and Stopping a recording session, as well as to set the parameters of that recording session. The 

outputs of this module are compressed sound files which are saved in the disk in selected 

locations. The module makes use of the preinstalled Windows XP sound drivers and codecs 

(compression decompression drivers). 

This manual provides information about some sound parameters that might be new to the user. 

 

5.4.2 Sound Module’s Main Window 
The Sound module’s main window, shown in figure 6.1 is called Capture Sound and it consists 

of three buttons and a status display. The three buttons are marked as Set, Start and Stop.  

 
Figure 5.4.1: Sound module’s main window. 

 

The three buttons implementation is as follows: 

Ø Set Button: Pressing the Set button will lead the user to another window, shown in figure 

6.2, which it is called Audio Setting. In this window the user can change the duration of 

the recording session, as well as the sampling rate1 (11.025kHz, 12kHz, 16kHz, 

22.050kHz, 32.000kHz etc.), the bits per sample (8 and 16) and the channels2 (Stereo and 

Mono). The Sound Module captures data in MS-PCM format and stores it on the systems 

hard drive and flash card in ALAW format. Ideal settings for a good recording session for 

this system are the following: 

o Sampling Rate: 32.000kHz 
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o Bits per Sample: 16 

o Channels: Stereo.  

 
1 Sampling Rate is the samples of data collected in a second. The sample rate is measured in Hertz. 
2 Number of channels in the waveform-audio data. Monaural data uses one channel and stereo data uses two channels. 
 

Figure 5.4.2: Audio Settings window. 

 

Ø Start Button: Pressing the Start button the application will start recording sound. 

Ø Stop Button: Pressing the Stop button the application will stop recording sound. 

 

5.4.3  Fast Fourier Transform Analysis 
The VDR/S-VDR system provides a reliable microphone test that ensures that the system's 

microphones are functional.  To do this every microphone is paired with a small buzzer that has 

a specific frequency output. The Sound module includes an FFT sub-module that is capable of 

conducting 22050 sample, 1024 points, FFT analysis of the incoming sound signal resulting in a 

5KHz frequency domain output. This output is used to record or recognize signals of a relatively 

steady frequency and intensity. A buzzer signal for example, will have a certain 'signature' 

(specific intensity in a specific frequency) in the frequency domain that the FFT analysis will be 

able to locate even within an extremely noisy environment. The installer must conduct a short 

test to find the dominant frequency of the buzzer (frequency with the maximum intensity) and 

then setup the Sound module to look for that intensity in the specific frequency when conducting 

the microphone tests. During the test the system will initiate a buzzing sound (one for each 

microphone) and look for its signature in the frequency domain of the incoming signal. If this 

signature is found then the specific microphone is operating properly.  
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Ø Graphics check box:  When selected it reveals an auxiliary window that displays a 

frequency/amplitude graph of the incoming sound. 

Ø Get Max Button: This button initiates an FFT analysis procedure where the module is 

searching for the dominant frequency of the incoming signal. The output value 

(frequency and intensity) may be used in order to setup the microphone test. 

 
 

Figure 5.4.3: Incoming sound shown in the Frequency Domain. 

 

Ø Check Button:  This button initiates an FFT analysis procedure where the module is 

searching for a specific frequency and intensity (signature) in the incoming signal. If this 

'signature' is found the indicator turns from red to green. 
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5.5 PC – PLC COMMUNICATIONS MODULE 
 

5.5.1 Purpose of the manual 
This product (VDR / S-VDR) contains a module called PC - PLC Communications Module. The 

purpose of that module is to help the user to Start and Stop the serial communications between 

the system’s (S-VDR) computer and the system’s PLC and its external modules. 

This manual provides the user with a quick introduction to the features of the PC – PLC 

Communications Module. 

 

7.5.2 Communications Module Main Window 
The PC – PLC Communications module’s main window, shown in figure 7.1 is called PLC - 

Communications and it consists of three buttons. The three buttons are marked as Hide, 

OpenPorts and ClosePorts.  

 
Figure 5.5.1: PC – PLC Communications module’s main window. 

 

The three buttons implementation is as follows: 
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Ø Hide Button: Pressing the Hide button the main window, illustrated in figure 7.1, will 

disappear. The module will carry working. 

Ø OpenPorts Button: Pressing the OpenPorts button will start the communications 

between the system’s computer and the system’s PLC and expansion modules. 

Ø ClosePorts Button: Pressing the ClosePorts button will pause the communications 

between the system’s computer and the system’s PLC and expansion modules. 

Ø Digital Inputs TextBox: it lays on the top of the form and displays the state of the digital 

inputs of the system. 

Ø Digital Outputs TextBox: It displays the state of the digital outputs of the system. 

Ø Digital Output CheckBoxes: Each CheckBox represents a digital output and its current 

value. The user can force the state of an output to change by clicking on it. 

Ø Analog Input Signal TextBoxes : these TextBoxes display the value (in Volts) of  the 

analogue inputs of the system.
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5.6 FOLDER MANIPULATION & DATA STORAGE 
5.6.1 Purpose of the manual 
This product (VDR / S-VDR) makes use of two additional applications. The one is called Folder 

Manipulation and the other one is called Save Wizard. The purpose of the first application is to 

make sure that the free space limits of the hard drive and the flash drive used by the system (S-

VDR) are not exceeded. The purpose of the second application is to allow the user to save an 

incident such as an accident or an emergency signal, which he/she might think that it is worth 

storing.  

 

This manual provides the user with a quick introduction to the features of the Folder 

Manipulation and the Save Wizard applications. 

 

5.6.2 Folder Manipulation 
The main window of the Folder Manipulation application is shown in figure 3.1. It is called after 

the applications name. It consists of three buttons, three boxes which can be edited and three 

status boxes. The three buttons are marked as Cancel, Apply and Exit.  

 
Figure 5.6.1: Main window of the Folder Manipulation application. 

 

The three buttons and six boxes implementations are as followed: 
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Ø Cancel Button: Cancels any changes that the user might have made to the Scanning 

Time, the hard drive’s Free Limit and the flash drive’s Free Limit boxes. The original 

values in the boxes are being displayed again. 

Ø Apply Button: Pressing the Apply button the application accepts any new changes that 

the user might have made. 

Ø Exit Button: Pressing the Exit button the application is being exited. 

Ø Scanning Time Box: Indicates the time period chosen by the user for the application to 

check if the HD’s and the Flash’s Free Limits have been exceeded. If the limits have been 

exceeded the applications deletes the oldest files. 

Ø Time Elapsed Box: Indicates the time remaining for the application to check if the HD’s 

and the Flash’s Free Limits have been exceeded. 

Ø HD’s Free Limit Box: Indicates the HD’s free space limit chosen by the user. This free 

space (in MBytes) is maintained at all times.  

Ø HD’s Data Path Box: Indicates the directory where the data is being stored on the HD. 

This is actually the first directory which is being manipulated by the programme. 

Ø Flash’s Free Limit Box: Indicates the Flash drive’s free space limit chosen by the user. 

This free space (in MBytes) is maintained at all times. 

Ø Flash’s Data Path Box: Indicates the directory where the data is being stored on the 

Flash drive. This is actually the second directory which is being manipulated by the 

programme. 

 

5.6.3 Data Storage 
This application (Save Wizard) consists of three windows, which have been designed to navigate 

the user step by step to choose the data, in other words the incident, such as an accident or an 

emergency signal that he/she considers worth saving.  

 

The programme starts with a welcoming window that explains to the user what this application is 

all about. This window is illustrated in figure 3.2.  
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Figure 5.6.2: Welcoming window of the Save Wizard application. 

 

As it can be seen from the above picture, on the window they are depicted three buttons. The 

three buttons are marked as Back, Next and Cancel. The three buttons implementations are as 

followed: 

Ø Back Button: This button is not active. 

Ø Next Button: Pressing the Next button the application takes the user to the next step (see 

Figure 3.3) where he/she decides what data wants to store. 

Ø Cancel Button: Pressing the Cancel button the application is being exited. 

 

The picture below (see Figure 3.3) shows the programme can actual do. In the section labelled as 

“Available data” in the system the user can see the oldest data in the system (indicated by a date 

and a time), as well as the newest data in the system, also indicated by a date and a time.  

 

In the following two sections labelled as “Beginning of incident” and “End of incident” the user 

can choose the period in which the incident occurred and he/she wants to save in the system. The 

period is defined the “form” and “to” dates and times.   
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Figure 5.6.3: Select Data to save window. 

 

As it can be seen from the above picture, on the window they are also depicted three buttons. 

The three buttons are marked as Back, Next and Cancel. The three buttons implementations are 

as followed: 

 

Ø Back Button: Pressing the Back button the application will return to the programmes 

previous window (Welcoming window). 

Ø Next Button: Pressing the Next button the application will start saving the data that was 

chosen by the user. If the saving procedure was successful then the window illustrated in 

figure 3.4 will appear. 

Ø Cancel Button: Pressing the Cancel button the application is being exited. 

 

If the saving process is successful then the programme will display the window depicted in 

figure 3.4. On the bottom right hand side corner of window called “End Wizard” there is a Finish 

buttons. Pressing the Back button the user will exit the application. 
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5.7 PLAYER 
5.7.1 Purpose of the manual 
This programme (Player) is a part of the BlueOcean peripheral applications provided with the 

VDR / S-VDR system. The purpose of the programme is to help the user to playback a recorded 

session of sound, radar images and emergency alarms that might had happened. This application 

makes use of the preinstalled Windows XP sound drivers and codecs (compression 

decompression drivers). The Player can also be run by the actual system (VDR / S-VDR). 

 

5.7.2 Player’s Main Window 
The Play’s main window is shown in figure 4.1 and it has taken its name after the program.  

 
Figure 5.7.1: The Player’s main window. 

From the Menu bar, through the command View, more windows with additional information 

may be opened. 

The application works as follows: 



Comas                Blue Ocean VDR / S-VDR  Setup Manual                                             
 

                                                                     5.   17/7/2007 46 

Ø After opening the Player the user will have to select File→Open on the main bar of the 

application, so that he/she should choose the directory from which the player will load its 

data. 

Ø One this has been done the “Select Start Date” and “Select End Date” boxes will be filled 

with the dates and times of available sessions stored in the system (hard drive or flash 

drive). The user might want to alter these default values. 

Ø One the top-left corner there is a control panel with various buttons and a slide bar. All 

these items can be used to move through the recording as if it where an ordinary 

multimedia device. 

 
Figure 5.7.2: The Player’s radar pictures viewing window. 

Ø Selecting View→Video from the main bar the user can view the radar pictures that were 

recorded during the specified period of time shown in the “Select Start Date” and “Select 

End Date” boxes. See figure 4.2. 

Ø Selecting View→FireDoors from the main bar the user can view the emergency signals 

that are emitted by the ship’s fire doors, which were recorded during the specified period 

of time shown in the “Select Start Date” and “Select End Date” boxes. See figure 4.3. 
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Figure 5.7.3: The Player’s fire doors emergency signals viewing window. 

 

Ø Selecting View→OpenDoors from the main bar the user can view the emergency signals 

that are emitted by the ship’s open doors, which were recorded during the specified 

period of time shown in the “Select Start Date” and “Select End Date” boxes. See figure 

4.4. 

 
Figure 5.7.4: The Player’s fire doors emergency signals viewing window. 
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As it was mention above the Player’s main window consists of some very helpful buttons and 

status boxes. Their implementation is being descripted below: 

 

Ø Play Button: After pressing the Play button the application will start reproducing the 

stored files that were chosen by the user. 

Ø Stop Button: After pressing the Stop button the application will stop reproducing the 

stored files that were chosen by the user. If the user presses the Start button again the 

application will start reproducing the stored files from the beginning. 

Ø Pause Button: The application will pause the reproduction at the current instant. Press 

pause again to continue. 

Ø 10 minutes forward/backwards Button: it will jump a 10 minutes space forward or 

backwards. 

Ø 1 minute forward/backwards Button: it will jump a one minute space forward or 

backwards. 

Ø Plus/Minus Button: This couple of buttons changes the reproduction speed of the player. 

The player can go up to 8 times faster the usual time. 

Ø Slide Bar: The slide bar shows the progress of the player within the defined time period. 

The resolution of the bar is one minute portions (wave files) and the user may slide to any 

part he wants to examine. 

Ø Current Sound/Video/Data/NMEA Playing Status Boxes: These Status Boxes display 

the files that are currently being reproduced. 

Ø Absolute Time Status Box: This Status Box displays the time passed since the sound 

file under reproduction started. 

 

Note: The Player is coordinating its timer with the Sound whenever there is an active 

WAV file playing. Otherwise the timer is updated from the system clock. 

 

Ø Current Time Status Box: This Status Box displays the time instant that the Player is 

reproducing. 

Ø Additional Recordings Text Box: This text box displays any additional, optional 

NMEA signals and their time of arrival. 

Ø SVDR state Panel: This  panel displays a simple graphical representation of the main 

VDR / S-VDR modules’ state. The colour significance is the following one: 
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Figure 5.7.5: VDR / S-VDR software state. 

 

Green: Module is working properly, 

Light Green: Non critical error occurred, 

Orange: Critical error occurred but module is still operating, 

Red: Module is not working at all and must be restarted.
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5.8 Data Transfer and Recovery 
 
5.8.1 Purpose of the manual 
In the previous section we described how to see the recorded data. The player works on data 
stored in a directory in the playback computer hard disk or on the VDR main unit disk.  
If the data are in the main unit it is simple to copy and examine them. The situation is different if 
we wish to read the data from a recovered capsule. 
 
5.8.2 Data transfer from an undamaged capsule 
 
There are two families of storage methods in the capsules. Some capsules exhibit themselves as a 
normal storage medium and other have proprietary storage and retrieval methods. 
 
In the first case data transfer is simple: connect the capsule according to manufacturer’s 
instructions and copy the data to a directory. Instruct the player to use that directory. No special 
tools are required. Standard FTP cables and the usual hubs can be used. 
 
In more detail: 
 
You will need: 
- a PC running Windows XP Professional, with a sound card, a network connection 
(Ethernet) and at least 5 GBytes free space in its hard disk 
- a 24 Vdc power supply capable of providing at least 3A.  
- Support software 
- a COMAS encryption key, if you plan to use the player on the same PC 
 
Contact our company for advice if in doubt. 
 
- Install the COMAS provided software in the PC: run the Setup program(s) in the root 
directory. Follow the instructions. Please accept all defaults provided. 
- insert the encryption key in a USB port 
- Find the 2 cables running from the capsule 
- Check the FTP cable. If the connector is damaged replace according to L3 Install manual 
(or the equivalent for your capsule – YYYY Install, YYYY being the capsule type) 
- Connect the FTP cable to the network connection of the PC 
- Set the PC at a fixed IP address in the 192.168.10.xxx subnet (not the .2, it is reserved for 
the capsule) 
- Connect the supply cable to the 24 Vdc power supply. Observe polarity. 
- Run the retrieval program. 
 
In the case of a capsule using proprietary storage and retrieval methods, for example as those 
manufactured by L3, a special program is used:  
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This client program copies all data from a capsule to a directory, regenerating the files and 
flagging errors. The program is preset to the required parameters, just press the “Start” button. 
After all files are transferred you can use the Player. Note that the player can use partial data, 
meaning that even if all data are not retrieved the saved data can be used. Both the client 
program and the player will flag all errors. If in doubt on the capsule type, ask for help from our 
support department. The name of the appropriate program is always YYYY client. 
 
All the necessary software is included on the CD named “COMAS SVDR support software” 
available free of charge to every approved investigation authority on request. Setup instructions 
are included. 
 
 
5.8.3 Data transfer from a damaged capsule 
 
Sometimes the retrieved capsule is damaged but the storage medium is intact. It is thus 
impossible to simply connect the capsule and read the data. In such cases the capsule 
manufacturer will connect the storage medium and read the data in a file. Regrettably no specific 
instructions can be given on the repair of a damaged capsule, as the possible conditions after a 
severe accident are numerous. For more details, see capsule manufacturer documentation.  
From this file we will retrieve the data with a program similar to L3 Client, but that program will 
read from a file instead of an IP address. A competent engineer will try to repair partially 
damaged files to help the authorities investigate the incident. 
 
- Retrieve the capsule 
- Close it as soon as possible in an air tide container to avoid further deterioration 
- Transport the container with extreme care: a damaged capsule is not as durable as a new 
one. 
- Contact COMAS or the capsule manufacturer for further instructions, describing in 
details capsule condition. 
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5.8.4 Copying data from the main unit 
 
All data that are written to the capsule are written to the main unit, too. The data are stored to the 
directory C:\SVDR and are normally not from the last 12 hours, but some days long. To copy 
data you need to put the SVDR out of service, as described in the firs part of this manual, and 
then copy data to an appropriate medium, for example a flash memory. All filenames contain 
date and time in sort able form: YYYYMMDDHHMMSSHH, meaning year, month, day, hour, 
minute, seconds and hundreds of seconds. Thus it is easy to find the files of interest and copy 
them to the external medium.
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Changes 
FolderManipulation instead of RunFolderManipulation ,  

Software System Description,   pg 1, 2. 
Updated to the new NMEA adapter,   NMEA ADAPTER MODULES,  pg 6, 7 
Added Encoder property to Video,   Video,      pg 7. 
Added properties to Files,   File Manipulation,    pg 7, 8 
Added Sound category   Sound,     pg 8 
Added System category   System,     pg 8 
The System information form has changed, System information   pg 15 
The Note was deleted         pg 16 
Comment added in first paragraph  Video     pg 27 
Two pages added for  the inst of VGA2USB Video     pg 30,31 
First paragraph changed   Video     pg 32 
Sound form and settings   Sound     pg 35 

 
 
 
 
 
 
    
 


